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ABSTARCT

In this project the proposed concept is to replace the manual work in drainage cleaning by
automated system controlled by micro-controller. Now-a-days even though automation
plays a vital role in all industrial applications in the proper disposal of sewage from
industries and commercials are still a challenging task. Drainage pipes are using for the
disposal and unfortunately sometimes there may be loss of human life while cleaning the
blockages in the drainage pipes. To overcome this problem and to save human life we
implement a design and construction of Automatic Drain Cleaner System. We designed
our project to use this in efficient way to control the disposal of wastages and with
regular filtration of wastages, clearance of gaseous substance are treated separately and

monitor the disposal in frequent manner.
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CHAPTER 1
INTRODUCTION

1.1 Introduction

The proper disposal of common wastes is still a challenge faced nowadays, even though
automation plays a vital role in the industrial and commercial applications. Usually what
we see in a country like India is that common wastes like plastic bottles, covers, sanitary
pads, etc and others are left in the streets and in the open drains. These waste particles
obviously cause blockage of the drainage system during monsoon season when there is a
flow of water through the roads and drainage systems. Also where the closed drainage
system open near a river causes the pollution of river. This blockage of drainage system

can cause accumulation of waste water in these drains.

Several water borne diseases such as cholera, worm disease, typhoid, malaria etc will
occur due to the contamination of these stagnant water. This can cause many health
issues and may even lead to deaths, other than the local common issues caused by the
blockage of drainage. In India, there is no existing automated mechanism by which this
blockage of drainage can be removed. Currently these blocked drains are cleared with the
help of manual workers were the workers have to get into the drains and manually
remove the wastes. In such situations the rate of diseases spread among these workers are

high and this affects their life’s and reduces their immunity.

Since the world is fast approaching towards the technology of digitalization and
automation, humans want every task and operations to be performed quickly and easily.
Now the time is for advanced techniques which can perform tasks efficiently and with
minimum time. The human wants to apply minimum effort in order to accomplish its
tasks. To achieve this there has to be automated techniques which can fulfill these
objectives. Hence in this project we tried to add this automation technology with the
knowledge of drainage systems in order to make the drainage cleaning system easy and
efficient tool for the cleaning of the drainage systems and hence save the environment.
For this we are using system by which drainage cleaner can do his work smartly using
communication through application.

The problem of the sewage disposal coming from the industries is growing rapidly day by

day and thus it needs to be resolved urgently since this problem is causing various



environmental issues and is very harmful to the human life. This is a real time problem
and it needs to resolved and overall speaking this proposed concept is very much efficient
in this work to be accomplished. Also, there is one more important advantage of this
drainage cleaning system is that the health of the workers working in drainage
scavenging can be improved and maintained since they have to no longer be in drainage
for its scavenging process. One more very useful and important advantage of our system
is that this system can replace the manual work done in sewage scavenging by a semi-
automatic scavenging system and the worker can access this system very easily and
efficiently.

1.2 Background Study

Automatic Drainage Water cleaning and Control System Using auto mechanism proposed
to overcome the real time problems. With the continued expansion of industries, the
problem of sewage water must be urgently resolved due to the increasing sewage
problems from industries of the surrounding environment. The waste and gases produced
from the industries are very harmful to human beings and to the environment. the
proposed system is to cleaning and control the drainage level using auto mechanism
technique. auto mechanism is the major controlling unit and the drainage level is monitor
by municipal . In this system we used motor, chain, driver, bucket, frame. Before
examine the function of a drive, we must understand the basic operation of the motor. It
is used to convert the electrical energy, supplied by the controller, to mechanical energy
to move the load. There are really two types of motors, AC and DC. The basic principles
are alike for both. Magnetism is the basis for all electric motor operation. It produces the

force required to run the motor.

1.3 Problem Statement

In today’s era automation plays a very important role in all industrial applications for the
proper disposal of sewage from industries and household is still a challenging task. Drain
pipes are used for the adequate disposal of waste and unfortunately sometimes there may
be a threat to human life during the cleaning of blockage in the drain pipes or it can cause
serious health issues because of the pertaining problems like malaria, dengue, etc.

In order to overcome this problem as well as to save human life we implement a design

“Automatic Drainage Cleaning System”. We designed our project in order to use it in an



efficient way to control the disposal of waste along with regular filtration of drains,
removal of solid waste in order to avoid blockage in drains to promote continuous flow of

drainage water which ultimately reduces the threat to human life.

1.4 Objective
We have some specific objectives for this project and they are pointed below:

To design & construction of Automatic Drain Cleaner system.

To implementation of micro-controller based Automatic Drain Cleaner system.

To take some output for future modification in our work.

To study the system performance for future reference and improvement purposes.

1.5 Structure of the Project

This Project is organized as follows:

Chapter 1 Introduction: The first chapter contains the statement of the introduction, our
background study for the project, problem statement, objectives of the study and the

project outline.

Chapter 2 Literature Review: The chapter two contains our introduction, literature review

part.

Chapter 3 Hardware and Software Analysis:Chapter three describes the theoretical model.
Here we mainly discuss about proposed system Hardware and software development of

our project etc.

Chapter 4 Methodology: Chapter three describes the theoretical model. Here we mainly
discuss about proposed system architecture in details with having block diagram, circuit

diagram, structural diagram, project working principle, complete project image etc.

Chapter 5 Result and Discussion: Chapter four deals with the result and discussion and

discuss about our project advantages and application.



Chapter 6 Conclusion: Chapter five all about our project conclusion and future scope.



CHAPTER 2
LITERATURE REVIEW

2.1 Literature Review

Ganesh U L, et.al. [1] Showed the usage of mechanical drainage cleaner to replace the
manual work required for drainage cleaning system. Drainage pipes are very dirty.
Sometimes it is harmful for human life while it is need for cleaning drainage system. To
overcome this problem, they implemented a mechanical semi-automatic drainage water
cleaner and so the water flow is efficient because of regular filtration of wastages with
the help of that project. Different kinds of environment hazards reduced with the help of

Drainage system machine.

Elangovan K., et.al. [2] Reviewed about drainage cleaning to replace manual work to
automated system because manually cleaning system it is harmful for human life and
cleaning time, is more so to overcome this problem they implemented a design
“Automatic drainage water pump monitoring and control system using PLC and
SCADA”. PLC and SCADA were designed. In this project to use efficient way to
control the disposal of wastage regularly, treatment of disposal in different way toxic and
non-toxic gases. PLC controller from Siemens was used in the treatment system of
drainage wastewater control by the stepper motor, compressor, gas exhauster, pressure
valve and the liquid level, flow and other analog variables to achieve automatic control

of sewage waste water treatment.

Dr.K.KUMARESAN [3] explained manual work converted to automated system.
Drainage pipe using for disposal and it may be loss for human life while cleaning the
blockage in the drainage pipes. To overcome this problem they implemented “Automatic
Sewage Cleaning System”. They designed their project different way clearance of
gaseous substance are treated separately so the flow of water efficiently. This project
may be developed with the full utilization of men , machines, and materials and money.
They made their project economical and efficient with the available resources. They used
automation technology concerned with his application of mechanical, electronics, and

computer based systems to operate and control production.



Sathiyakala, et.al. [4] explained E bucket (electronic bucket) use for drainage cleaning
system because E-bucket lifted a sewage and used evaporation treatment for this sewage
wet sewage was converted into dry matters, with the of ARM board (ARDUINO) this
process was performed. After this process they were add this waste a government bank

without any kind of affection of the bacteria.

S D Rahul Bharadwaj, et.al. [5] Proposed with the automatic cleaning of waste water in
order to prevent global warming and melting of glaciers. The results emphasize the need
of waste water treatment plants, through which the water is treated before suspending in
rivers. Firstly power is generated and that power is used for waste water cleaning
process.

NitinSall, et.al. [6] Explained flow of used water from homes, business industries, and
commercial activities is called waste water. 200 and 500 liters wastage water are
generated each person every day. So using waste water technology that removes, rather

than destroys, a pollutant in a drainage system.

Mr. Nikhil S. Pisall, et.al. [7] Proposed safe load for the chain and the ability of the
same to withstand the use of Finite Element Modeling would be the core objective of the
work. An existing chain link was used for benchmarking the research work. Finite
Element Analysis tools like Hyper Mesh and ANSYS were suitable to find the
performance of the link under tensile loads. The design for the chain would be subjected
to F.E Analysis to find the effect of loads (tension) on the link. The proposed method
utilizes software in the FEA domain for analyzing the effects of the variation in the
values of the design parameters influencing the performance criterion. The FEM method
is used to analyze the stress state of an elastic body with a given geometry, such as chain
link.

NDUBUISI C. Daniels, et.al. [8] Showed the Drainage system cleaner machine used to
remove garbage and sewage automatically which helped to protect the environment from
different kinds of environmental hazards. The drainage system cleaner has three major
parts which are the Propeller, the Cleaner and the Pan all makes up for its effective

functioning.



Shao-Wu-Zhang, et.al. [9] Introduced three drainage devices about the ceramic filter
dewatering system, improved the design according to the short coming of drainage
device and working mechanism of automatic drainage device. This device have stable
performance, low cost and low failure rate. They compared the working processes of
three drainage devices, and analyzed its future development. Their aim was the
shortcomings of the three types of drainage devices and their application situations, the

automatic drainage device was improved.

Prof S.D.Anap, et.al. [10], showed blockage is the major cause of the pollution and
flooding in the metro cities. They have designed the drainage blockage detection system
to avoid such problems. The system provides monitoring of drainage condition and to
inform authorities of these condition. This design preset an implementation wireless
sensor network in the monitoring of drainage system using GSM system. To detecting
blockage and monitoring water level condition we use level sensor. They explained
about the design of the cost effective, easy method to control the water level of the tank
wirelessly and automatically. They used level and IR sensor to monitor and control

drainage blockage. They also used solenoid valve for bypass purpose.

James C.Y. Guo, et.al. [11] Showed roadway sanding is a common practice in cold
regions because sand increases the roadway friction when mixing with snow. In this
study, a snow storage element is introduced to the renascence project of a mountainous
highway which is running through an environmental sensitive forest area in Colorado.
Recovery of winter sanding material from the highway was designed to be a joint effort
of surface runoff and sweeping machines. As a tradeoff exist between sand recovery and
size of snow storage area. This study also presented a maximization methodology by
which the size of snow storage area can be determined by the diminishing return of sand

recovery.

James C. Conwell, G. E. Jhonson [12] proposed the design and construction of a new test
machine configuration that offers same advantages over the traditional one. The new
machine and attendant instrumentation provide more realistic chain loading and allow
link tension and roller sprocket impact monitoring during normal operation. The
incorporation of idle sprocket allows independent adjustment of test on length and

preload.



Prabhushankar, et.al. [13] Showed dewatering of drainage is generally done using
centrifugal pump, but using centrifugal pump is not much effective in complete removal
of the suspended and heavy solids and also it consumes lot of electric power for its
operation. The main aim of the proposed work was to remove drainage water by the
pneumatic operated spring return reciprocating pump. It reduced the man power required
for the drainage cleaning activity. Instead of slider crank mechanism the pneumatic and
spring system with reciprocating cylinder was used which discharged the large sized
drainage particles easily and there was no need of external power supply.

Gregor Burger, et.al. [14] Described the concept and software design of an innovative
general purpose platform for network based model development and look at some of
crucial computational design issues. They developed the improvement in the design of
very fast, easy to use, easy to integrate and extensible general purpose simulator
platform. It was running up to 40 times faster than its MATLAB based predecessor and
allowing it to be flexibly applied. They included features such as the hot-start
mechanism and the extension interfaces have proven to be extremely useful when

linking city drain 3 as a sub-model into larger software project.

MsT.Deepiga, et.al. [15] Defined the water monitoring systems such as Tank water
pollution monitoring and water pipeline leakage sensing monitoring. They avoided huge
amount of water wasted by uncontrolled use of large apartments. They used the PID

based water level monitoring to indicate the level of water in the tank.

2.2 Summary
We try to do this project by reading the above literature, and we have been able to make

our project successful by reducing the mistakes of last year's project.



CHAPTER 3
HARDWARE AND SOFTWARE ANALYSIS

3.1 Arduino Pro Mini

The Arduino Pro Mini is a micro-controller board based on the ATmegal68. It has 14
digital input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, an
on-board resonator, a reset button, and holes for mounting pin headers. A six pin header
can be connected to an FTDI cable to provide USB power and communication to the

board.

.

s | g

RN

000000

Figure 3.1: Arduino Pro Mini
Specification

e Micro-controller ATmegal68

e Operating Voltage: 3.3V or 5V (depending on model)

e Input Voltage: 3.35 -12 V (3.3V model) or 5 - 12 V (5V model)
e Digital 1/0 Pins: 14 (of which 6 provide PWM output)

e Analog Input Pins: 6

e DC Current per 1/0 Pin: 40 mA

e Flash Memory: 16 KB (of which 2 KB used by boot loader)

e SRAM:1KB

e EEPROM: 512 bytes

e Clock Speed: 8 MHz (3.3V model) or 16 MHz (5V model)



Pin Out

Each of the 14 digital pins on the Pro Mini can be used as an input or output, using pin
Mode(), digital Write(), and digital Read() functions. They operate at 3.3 or 5 volts
(depending on the model). Each pin can provide or receive a maximum of 40 mA and has
an internal pull-up resistor (disconnected by default) of 20-50 kOhms. In addition, some
pins have specialized functions:

e Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial

data. These pins are connected to the TX-0 and RX-1 pins of the six pin header.

o External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt
on a low value, a rising or falling edge, or a change in value. See the
attachlInterrupt() function for details.

e PWM: 3,5, 6,9, 10, and 11. Provide 8-bit PWM output with the analogWrite()

function.

e SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI
communication, which, although provided by the underlying hardware, is not

currently included in the Arduino language.

e LED: 13. There is a built-in LED connected to digital pin 13. When the pin is
HIGH value, the LED is on, when the pin is LOW, it's off.

The Pro Mini has 6 analog inputs, each of which provide 10 bits of resolution (i.e.
1024 different values). Four of them are on the headers on the edge of the board;
two (inputs 4 and 5) on holes in the interior of the board. The analog inputs
measure from ground to VCC. Additionally, some pins have specialized

functionality:

e 12C: 4 (SDA) and 5 (SCL). Support 12C (TWI) communication using the Wire
library.

There is another pin on the board:

e Reset. Bring this line LOW to reset the micro controller. Typically used to add a

reset button to shields which block the one on the board.
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See also the mapping between Arduino pins and ATmegal68 ports.

Tx0 Vin
RXI GND
RST RST
GND Vee A5
2 A3 e
3 A2
ATmega628p 4 A1
Microcontroller g A0
6 13
12
I 17 Reset
8 Button
9 10

GND A7 A6

Figure 3.2: Arduino Pro Mini Pin Out

Micro controller IC ATmega328p

Figure 3.3: Micro controller IC AT Mega 328p

The high-performance Microchip Pico Power 8-bit AVR RISC-based micro controller
combines 32KB ISP flash memory with read-while-write capabilities, 1024B EEPROM,
2KB SRAM, 23 general purpose 1/O lines, 32 general purpose working registers, three
flexible timer/counters with compare modes, internal and external interrupts, serial
programmable USART, a byte-oriented 2-wire serial interface, SPI serial port, a 6-
channel 10-bit A/D converter (8-channels in TQFP and QFN/MLF packages),
programmable watchdog timer with internal oscillator, and five software selectable

power saving modes. The device operates between 1.8-5.5 volts. By executing powerful

11



instructions in a single clock cycle, the device achieves throughputs approaching 1 MIPS

per MHz, balancing power consumption and processing speed.

3.2 L293D Motor Driver IC

The L293D is a popular 16-Pin Motor Driver IC. As the name suggests it is mainly used to
drive motors. A single L293D IC is capable of running two DC motors at the same time;

also the direction of these two motors can be controlled independently.

Enable 1, 2 Veel (Vss)

Output 4

Ground Ground

Ground

Ground

Output 3

dOORRanE

Vee2 (Vs) Enable 3, 4

Figure 3.4: Motor driver ic L293D

Working Process:

L293D IC is a typical Motor Driver IC which allows the DC motor to drive on any
direction. This IC consists of 16-pins which are used to control a set of two DC motors
instantaneously in any direction. It means, by using a L293D IC we can control two DC

motors.

Features

e Can be used to run Two DC motors with the same IC.

e Speed and Direction control is possible

12



e Motor voltage Vcc2 (Vs): 4.5V to 36V

e Maximum Peak motor current; 1.2A

e Maximum Continuous Motor Current: 600mA
e Supply Voltage to Vccl(vss): 4.5V to 7V
e Transition time: 300ns (at 5Vand 24V)

o Automatic Thermal shutdown is available

L293D Pin Configuration

Pin Number Pin Name Description

This pin enables the input pin Input 1(2) and Input
1 Enable 1,2 P PELP put 1(2) P

2(7)

Directly controls the Output 1 pin. Controlled by
2 Input 1 o o

digital circuits
3 Output 1 Connected to one end of Motor 1
4 Ground Ground pins are connected to ground of circuit (0V)
5 Ground Ground pins are connected to ground of circuit (0V)
6 Output 2 Connected to another end of Motor 1

Directly controls the Output 2 pin. Controlled by
7 Input 2 . o

digital circuits

Connected to Voltage pin for running motors (4.5V
8 Vee2 (Vs)

to 36V)

This pin enables the input pin Input 3(10) and Input
9 Enable 3,4 P PELP put 3(10) P

4(15)

Directly controls the Output 3 pin. Controlled by
10 Input 3 o o

digital circuits
11 Output 3 Connected to one end of Motor 2
12 Ground Ground pins are connected to ground of circuit (0V)
13 Ground Ground pins are connected to ground of circuit (0V)
14 Output 4 Connected to another end of Motor 2
15 Input 4 Directly controls the Output 4 pin. Controlled by

13




digital circuits

16

Vcee2 (Vss)

Connected to +5V to enable IC function

Use of a L293D Motor Driver IC:

Using this L293D motor driver IC is very simple. The IC works on the principle of HalfH-

Bridge, let us not go too deep into what H-Bridge means, but for now just know that H

bridge is a set-up which is used to run motors both in clock wise and anti-clockwise

direction. As said earlier this IC is capable of running two motors at the any direction at

the same time, the circuit to achieve the same is shown below.

+5V

A

+12v

4

T U1
16 8
D’!
?: NI VSS VS oOuTi é
.' | =1 2 ouT2
150 14
D.' I_ INe GND GND OUT4
L293D

I

Figure 3.5: L293D circuit Diagram

All the Ground pins should be grounded. There are two power pins for this IC, one is the

Vss(Veel) which provides the voltage for the IC to work, this must be connected to +5V.

The other is Vs(Vcc2) which provides voltage for the motors to run, based on the

14




specification of your motor you can connect this pin to anywhere between 4.5V to 36V,

here | have connected to +12V.

The Enable pins (Enable 1,2 and Enable 3,4) are used to Enable Input pins for Motor 1
and Motor 2 respectively. Since in most cases we will be using both the motors both the
pins are held high by default by connecting to +5V supply. The input pins Input 1,2 are
used to control the motor 1 and Input pins 3,4 are used to control the Motor 2. The input
pins are connected to the any Digital circuit or microcontroller to control the speed and

direction of the motor.

Applications

o Used to drive high current Motors using Digital Circuits
e Can be used to drive Stepper motors
e High current LED’s can be driven

o Relay Driver module (Latching Relay is possible)

3.3 Relay

Arelay is an electrically operated switch. Many relays wuse an electromagnet to
mechanically operate a switch, but other operating principles are also used, such as solid-
state relays. Relays are used where it is necessary to control a circuit by a separate low-
power signal, or where several circuits must be controlled by one signal. The first relays
were used in long distance telegraph circuits as amplifiers: they repeated the signal coming
in from one circuit and re-transmitted it on another circuit. Relays were used extensively in

telephone exchanges and early computers to perform logical operations.

15
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Coi g L Com
— E
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Figure 3.6: Relay

A type of relay that can handle the high power required to directly control an electric
motor or other loads is called a contactor. Solid-state relays control power circuits with
no moving parts, instead using a semiconductor device to perform switching. Relays with
calibrated operating characteristics and sometimes multiple operating coils are used to
protect electrical circuits from overload or faults; in modern electric power systems these

functions are performed by digital instruments still called “protective relays".

Magnetic latching relays require one pulse of coil power to move their contacts in one
direction, and another, redirected pulse to move them back. Repeated pulses from the same
input have no effect. Magnetic latching relays are useful in applications where interrupted
power should not be able to transition the contacts. Magnetic latching relays can have
either single or dual coils. On a single coil device, the relay will operate in one direction

when power is applied with one polarity, and will reset when the polarity is reversed.

On a dual coil device, when polarized voltage is applied to the reset coil the contacts will
transition. AC controlled magnetic latch relays have single coils that employ steering
diodes to differentiate between operate and reset commands. The circuit above is called a
low-side switch, because the switch — our transistor — is on the low (ground) side of
the circuit. Alternatively, we can use a PNP transistor to create a high-side switch: Similar

to the NPN circuit, the base is our input, and the emitter is tied to a constant voltage.

16
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VCC

NO
1 RLA Relay Contact
12V
Logic 1=ON § <TEXp>
Logic 0=OFF Relay Coil NC
CONTROL
‘

Figure 3.7: Transistor Switching Circuit.

A relay is an electrically operated switch of mains voltage. It means that it can be turned
on or off, letting the current go through or not. Controlling a relay with the Arduino is as

simple as controlling an output such as an LED. The relay module is the one in the figure
below.

Figure 3.8: Relay Module

This module has two channels (those blue cubes). There are other varieties with one, four
and eight channels.

Mains voltage connections:

In relation to mains voltage, relays have 3 possible connections:

17



Figure 3.9: Pin diagram of Relay Module

COM: common pin

NO (Normally Open): there is no contact between the common pin and the normally open
pin. So, when you trigger the relay, it connects to the COM pin and supply is provided to a

load

NC (Normally Closed): there is contact between the common pin and the normally closed
pin. There is always connection between the COM and NC pins, even when the relay is
turned off. When you trigger the relay, the circuit is opened and there is no supply

provided to a load.

If you want to control a lamp for example, it is better to use a normally-open circuit,

because we just want to light up the lamp occasionally.
Pin wiring:

The connections between the relay module and the Arduino are really simple:
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Figure 3.10: Main Voltage Connection

® GND: goes to ground
® IN1: controls the first relay (it will be connected to an Arduino digital pin)

® IN2: controls the second relay (it should be connected to an Arduino digital pin if you

are using this second relay. Otherwise, you don’t need to connect it)

® V/CC:goesto5V

3.4 DC Gear Motor

Description:

A DC motor is any motor within a class of electrical machines whereby direct current
electrical power is converted into mechanical power. A 12v DC motor is small and

inexpensive, yet powerful enough to be used for many applications.
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Specification:

e Voltage: 12V DC

e Gear ratio: 1/31

e No-load speed: 200 RPM

e Rated Speed: 140 RPM

e Rated torque: 10 kg.cm

e Rated current: 2.5 Amp

e Length of Motor(including spindle): 106 mm/4.17"
e  Diameter: 37 mm/1.45"

e  Shaft length: 21 mm/0.82"

e  Shaft diameter: 6 mm/0.24"

Figure 3.11: DC Gear Motor

3.5 Regulator IC

Voltage sources in a circuit may have fluctuations resulting in not providing fixed voltage
outputs. A voltage regulator IC maintains the output voltage at a constant value. 7805 IC,
a member of 78xx series of fixed linear voltage regulators used to maintain such
fluctuations, is a popular voltage regulator integrated circuit (IC). The xx in 78xx
indicates the output voltage it provides. 7805 IC provides +5 volts regulated power

supply with provisions to add a heat sink.
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Figure 3.12: 5V Regulator IC
7805 IC Rating:

e Input voltage range 7V- 35V

e Currentrating Ic = 1A

e Output voltage range V. Max=5.2V ,V. Min=4.8V

3.6 Ultrasonic Sensor

An ultrasonic sensor is an electronic device that measures the distance of a target object
by emitting ultrasonic sound waves, and converts the reflected sound into an electrical
signal. Ultrasonic waves travel faster than the speed of audible sound (i.e. the sound that
humans can hear). Ultrasonic sensors have two main components: the transmitter (which
emits the sound using piezoelectric crystals) and the receiver (which encounters the
sound after it has travelled to and from the target).

HC-SR04 Ultrasonic Sensor - Working

As shown above the HC-SR04 Ultrasonic (US) sensor is a 4 pin module, whose pin names
are \Vcc, Trigger, Echo and Ground respectively. This sensor is a very popular sensor used
in many applications where measuring distance or sensing objects are required. The
module has two eyes like projects in the front which forms the Ultrasonic transmitter and

Receiver. The sensor works with the simple high school formula that

Distance = Speed x Time
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The Ultrasonic transmitter transmits an ultrasonic wave, this wave travels in air and when
it gets objected by any material it gets reflected back toward the sensor this reflected wave

is observed by the Ultrasonic receiver module as shown in the picture below-

Figure 3.13: Working of sensor

Now, to calculate the distance using the above formulae, we should know the Speed and
time. Since we are using the Ultrasonic wave we know the universal speed of US wave at
room conditions which is 330m/s. The circuitry inbuilt on the module will calculate the
time taken for the US wave to come back and turns on the echo pin high for that same
particular amount of time, this way we can also know the time taken. Now simply

calculate the distance using a micro controller or microprocessor.

How to use the HC-SR04 Ultrasonic Sensor

HC-SR04 distance sensor is commonly used with both micro controller and
microprocessor platforms like Arduino, ARM, PIC, Raspberry Pie etc. The following
guide is universally since it has to be followed irrespective of the type of computational
device used. Power the Sensor using a regulated +5V through the Vcc ad Ground pins of
the sensor. The current consumed by the sensor is less than 15mA and hence can be
directly powered by the on board 5V pins (If available). The Trigger and the Echo pins are
both 1/0O pins and hence they can be connected to 1/O pins of the microcontroller. To start
the measurement, the trigger pin has to be made high for 10uS and then turned off. This
action will trigger an ultrasonic wave at frequency of 40Hz from the transmitter and the

receiver will wait for the wave to return.
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Once the wave is returned after it getting reflected by any object the Echo pin goes high
for a particular amount of time which will be equal to the time taken for the wave to return
back to the sensor.The amount of time during which the Echo pin stays high is measured
by the MCU/MPU as it gives the information about the time taken for the wave to return
back to the Sensor. Using this information, the distance is measured as explained in the

above heading.

Applications

e Used to avoid and detect obstacles with robots like biped robot, obstacle avoider
robot, path finding robot etc.

e Used to measure the distance within a wide range of 2cm to 400cm

e Can be used to map the objects surrounding the sensor by rotating it

e Depth of certain places like wells, pits etc can be measured since the waves can

penetrate through water

Ultrasonic Sensor Pin Configuration

Pin
Pin Name Description
Number

1 Vce The Vcc pin powers the sensor, typically with +5V

) Trigger pin is an Input pin. This pin has to be kept high
2 Trigger - :

for 10us to initialize measurement by sending US wave.

Echo pin is an Output pin. This pin goes high for a
3 Echo period of time which will be equal to the time taken for

the US wave to return back to the sensor.
4 Ground This pin is connected to the Ground of the system.

Table: Ultrasonic Sensor Pin Configuration
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HC-SR04 Sensor Features

e Operating voltage: +5V

e Theoretical Measuring Distance: 2cm to 450cm
e Practical Measuring Distance: 2cm to 80cm

e Accuracy: 3mm

e Measuring angle covered: <15°

e Operating Current: <15mA

e Operating Frequency: 40Hz

3.7 Battery

A twelve-volt battery has six single cells in series producing a fully charged output voltage
of 12.6 volts. A battery cell consists of two lead plates a positive plate covered with a paste
of lead dioxide and a negative made of sponge lead, with an insulating material (separator)

in between.
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Figure 3.14: 12V Battery
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3.8 The Smoothing Capacitor

When there is a potential difference across the conductors (e.g., when a capacitor is
attached across a battery), an electric field develops across the dielectric, causing positive
charge (+Q) to collect on one plate and negative charge (-Q) to collect on the other plate.
If a battery has been attached to a capacitor for a sufficient amount of time, no current can
flow through the capacitor. However, if an accelerating or alternating voltage is applied

across the leads of the capacitor, a displacement current can flow.

Figure 3.15: Capacitor

An ideal capacitor is characterized by a single constant value for its capacitance.
Capacitance is expressed as the ratio of the electric charge (Q) on each conductor to the
potential Difference (V). The Sl unit of capacitance is the farad (F), which is equal to one
coulomb per volt (1 C/V). Typical capacitance values range from about 1 pF (10—-12 F) to
about 1 mF (10—3 F). The capacitance is greater when there is a narrower separation

between conductors and when the conductors have a larger surface area.

In practice, the dielectric between the plates passes a small amount of leakage current and
also has an electric field strength limit, known as the breakdown voltage. The conductors
and leads introduce an undesired inductance and resistance. Capacitors are widely used in
electronic circuits for blocking direct current while allowing alternating current to pass. In
analog filter networks, they smooth the output of power supplies. In resonant circuits they
tune radios to particular frequencies. In electric power transmission systems, they stabilize

voltage and power flow.
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The full-wave bridge rectifier however, gives us a greater mean DC value (0.637 Vmax)
with less superimposed ripple while the output waveform is twice that of the frequency of
the input supply frequency. We can improve the average DC output of the rectifier while
at the same time reducing the AC variation of the rectified output by using smoothing
capacitors to filter the output waveform. Smoothing or reservoir capacitors connected in
parallel with the load across the output of the full wave bridge rectifier circuit increases the
average DC output level even higher as the capacitor acts like a storage device as shown
below. Too low a capacitance value and the capacitor has little effect on the output
waveform. But if the smoothing capacitor is sufficiently large enough (parallel capacitors
can be used) and the load current is not too large, the output voltage will be almost as

smooth as pure DC.

Bridge
Rectifier

Y, e
3 C rd
48 ' | Load
Smoothing : :
Capacitor '
ov
C Charges C Discharges - Waveform
Ripple A v -~ with

— T — — T — N aa
e

E R, Vb
ovd ') V ') \ Capacitor

Resultant Output Waveform

Figure 3.16: The Smoothing Capacitor with Full Bridge Rectifier

3.9 Resistor

A resistor is a passive two-terminal electrical component that implements electrical
resistance as a circuit element. Resistors act to reduce current flow, and, at the sometime,
act to lower voltage levels within circuits. Resistors may have fixed resistances or variable
resistances, such as those founding thermostats, visitors, trimmers, photo resistors,
hamsters and potentiometers. The current through a resistor is in direct proportion to the

voltage across the resistor's terminals. This relationship is represented by Ohm's law.
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Figure 3.17: Resistor

Theory of operation:

The behavior of an ideal resistor is dictated by the relationship specified by Ohm ‘slaw:
V=IR

Ohm's law states that the voltage (V) across a resistor is proportional to the current (1),
where the constant of proportionality is the resistance (R).

Equivalently, Ohm's law can be stated:
| =VIR

This formulation states that the current (1) is proportional to the voltage (V) and inversely
proportional to the resistance (R). This is directly used in practical computations. For
example, if a 300 ohm resistor is attached across the terminals of al2 volt battery, then a
current of12 / 300 = 0.04 amperes flows through that resistor.

3.10 Arduino IDE

The digital micro controller unit named as Arduino Nano can be programmed with the
Arduino software IDE. There is no any requirement for installing other software rather
than Arduino. Firstly, Select "Arduino Nano from the Tools, Board menu (according to the
micro controller on our board). The IC used named as ATmega328 on the Arduino Nano
comes pre burned with a boot loader that allows us to upload new code to it without the

use of an external hardware programmer.

Communication is using the original STK500 protocol (reference, C header files). We can

also bypass the boot loader and programs the micro controller through the ICSP (In Circuit
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Serial Programming) header. The ATmegal6U2 (or 8U2 in the revl and rev2 boards)
firmware source code is available. The ATmegal6U2/8U2 is loaded with a DFU boot
loader, which can be activated by:

On Rev1 boards: connecting the solder jumper on the back of the board (near the map of
Italy) and then resetting the 8U2. On Rev2 or later boards: there is a resistor that pulling
the 8U2/16U2 HWB line to ground, making it easier to put into DFU mode.

The Arduino Nano is one of the latest digital microcontroller units and has a number of
facilities for communicating with a computer, another Arduino, or other microcontrollers.
The ATmega328 provides UART TTL at (5V) with serial communication, which is
available on digital pins 0 -(RX) for receive the data and pin no.1 (TX) for transmit the
data. An ATmegal6U2 on the board channels this serial communication over USB and
appears as a virtual com port to software on the computer. The '16U2 firmware uses the
standard USB COM drivers, and no external driver is needed. However, on Windows, an
.in file is required. The Arduino software includes a serial monitor which allows simple

textual data to be sent to and from the Arduino board.

€9 sketch_sep14a | Arduino 1.6.11 (Windows Store 1.6.11.0) — a X
File Edit Sketch Tools Help

sketch_sep14a

void setup() {

/ put your setup code

Arduino/Genuino Uno on COM1

Figure 3.18: Arduino Software Interface IDE
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The RX and TX LEDs on the board will flash when data is being transmitted via the USB-
to-serial chip and USB connection to the computer (but not for serial Communication on
pins 0 and 1). A Software Serial library allows for serial communication on any of the
Nano's digital pins. The ATmega328 also supports 12C (TWI) and SPI communication.

The Arduino software includes a Wire library to simplify use of the 12C bus. Arduino
programs are written in C or C++ and the program code written for Arduino is called
sketch. The Arduino IDE uses the GNU tool chain and AVR Lab to compile programs,
and for uploading the programs it uses argued. As the Arduino platform uses Atmel micro-
controllers, Atmel's development environment, AVR Studio or the newer Atmel Studio,
may also be used to develop software for the Arduino. The Arduino Integrated
Development Environment - or Arduino Software (IDE) - contains a text editor for writing
code, a message area, a text console, a toolbar with buttons for common functions and a
series of menus. It connects to the Arduino and Genuino hardware to upload programs and

communicate with them.

Writing Sketches

Programs written using Arduino Software (IDE) are called sketches. These sketches are
written in the text editor and are saved with the file extension .ino. The editor has features
for cutting/pasting and for searching/replacing text. The message area gives feedback
while saving and exporting and also displays errors. The console displays text output by
the Arduino Software (IDE), including complete error messages and other information.
The bottom right hand corner of the window displays the configured board and serial port.
The toolbar buttons allow you to verify and upload programs, create, open, and save

sketches, and open the serial monitor.
Sketchbook

The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to store
your programs (or sketches). The sketches in your sketchbook can be opened from the File
> Sketchbook menu or from the Open button on the toolbar. The first time you run the
Arduino software, it will automatically create a directory for your sketchbook. You can
view or change the location of the sketchbook location from with the Preferences dialog.

Beginning with version 1.0, files are saved with a .ino file extension. Previous versions use
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the .pde extension. You may still open .pde named files in version 1.0 and later, the

software will automatically rename the extension to .ino.
Tabs, Multiple Files, and Compilation

Allows you to manage sketches with more than one file (each of which appears in its own
tab). These can be normal Arduino code files (no visible extension), C files (.c extension),

C++ files (.cpp), or header files (.h).
Uploading

Before uploading your sketch, you need to select the correct items from the Tools > Board
and Tools > Port menus. The boards are described below. On the Mac, the serial port is
probably something like /dev/tty.usbmodem?241 (for a Uno or Mega2560 or Leonardo) or
/devl/tty.usbserial-1B1  (for a Duemilanove or earlier USB board), or
/dev/tty. USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial
adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4,
COM5, COMY7, or higher (for a USB board) - to find out, you look for USB serial device
in the ports section of the Windows Device Manager. On Linux, it should be
/dev/ttyACMXx , /dev/ttyUSBx or similar. Once you've selected the correct serial port and
board, press the upload button in the toolbar or select the Upload item from the Sketch
menu. Current Arduino boards will reset automatically and begin the upload. With older
boards (pre-Diecimila) that lack auto-reset, you'll need to press the reset button on the
board just before starting the upload. On most boards, you'll see the RX and TX LEDs
blink as the sketch is uploaded. The Arduino Software (IDE) will display a message when

the upload is complete, or show an error.

When you upload a sketch, you're using the Arduino Bootloader, a small program that has
been loaded on to the microcontroller on your board. It allows you to upload code without
using any additional hardware. The Bootloader is active for a few seconds when the board
resets; then it starts whichever sketch was most recently uploaded to the microcontroller.
The Bootloader will blink the on-board (pin 13) LED when it starts (i.e. when the board

resets).
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Libraries

Libraries provide extra functionality for use in sketches, e.g. working with hardware or
manipulating data. To use a library in a sketch, select it from the Sketch > Import Library
menu. This will insert one or more #include statements at the top of the sketch and
compile the library with your sketch. Because libraries are uploaded to the board with your
sketch, they increase the amount of space it takes up. If a sketch no longer needs a library,
simply delete its #include statements from the top of your code. There is a list of libraries
in the reference. Some libraries are included with the Arduino software. Others can be
downloaded from a variety of sources or through the Library Manager. Starting with
version 1.0.5 of the IDE, you do can import a library from a zip file and use it in an open

sketch. See these instructions for installing a third-party library.
Third-Party Hardware

Support for third-party hardware can be added to the hardware directory of your
sketchbook directory. Platforms installed there may include board definitions (which
appear in the board menu), core libraries, Bootloaders, and programmer definitions. To
install, create the hardware directory, then unzip the third-party platform into its own sub-
directory. (Don't use "Arduino” as the sub-directory name or you'll override the built-in
Arduino platform.) To uninstall, simply delete its directory. For details on creating
packages for third-party hardware, see the Arduino IDE 1.5 3rd party Hardware

specification.

Serial Monitor

This displays serial sent from the Arduino or Genuino board over USB or serial connector.
To send data to the board, enter text and click on the "send" button or press enter. Choose
the baud rate from the drop-down menu that matches the rate passed to Serial begin in
your sketch. Note that on Windows, Mac or Linux the board will reset (it will rerun your

sketch) when you connect with the serial monitor.
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3.11 Proteus Software

The Proteus Design Suite is a proprietary software tool suite used primarily for electronic
design automation. The software is used mainly by electronics design engineers and
technicians to create schematics and electronics prints for manufacturing printed circuit

boards.

Automatic Drain Cleaner - ISIS Professional
File View Edit Tools Design Graph Source Debug Library Template System Help
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Figure 3.19: Proteus Software Interface

The first version of what is now the Proteus Design Suite was called PC-B and was
written by the company chairman, John Jameson, for DOS in 1988. Schematic Capture
support followed in 1990 with a port to the Windows environment shortly thereafter.
Mixed mode SPICE Simulation was first integrated into Proteus in 1996 and
microcontroller simulation then arrived in Proteus in 1998. Shape based auto routing was
added in 2002 and 2006 saw another major product update with 3D Board Visualization.
More recently, a dedicated IDE for simulation was added in 2011 and MCAD
import/export was included in 2015. Support for high speed design was added in 2017.
Feature led product releases are typically biannual, while maintenance-based service

packs are released as required.
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CHAPTER 4
METHODOLOGY

4.1 Our methodologies for the project

Our methodologies for the project:

® Creating an idea for Design and construction of Automatic Drain Cleaner
system.

® And designing a block diagram & circuit diagram to know which components
need to construct it.

® Collecting the all components and programming for the micro controller to
controlled the system.

® Setting all components in a PCB board & soldering. Then assembling the all

block in a board and finally run the system & checking.

g Controller

Suctaior

4.2 Structural Design

Battery

Figure 4.1: Our Project Structural View
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4.3 Block Diagram
The way of whole project works is that we use battery from the supply voltage and control
the all module. We use Arduino micro controller which is mainly control our project. Here

we also use various instrument which is visible in this block diagram.

|
Battery I
Motor
—> Driver
Ultrasonic
Sensor
Arduino
>
Relay

Figure 4.2: Block Diagram of Our System

4.4 Schematic Diagram

The schematic diagram here is representing the electrical circuit and the components of

the project. Here we have used standardized symbols and lines.
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Figure 4.3: Schematic Diagram of the Project

4.5 Working Principle

The Device is place across drain so that only water flow through lower grids. Waste like
bottle, etc. Floating in drain are lifted by teeth which is connected to chain. This chain is
attached by gears driven by motor. The energy provided to motor is 12V battery
connected to it. When motor runs the chain starts to circulate making teeth to lift up. The
waste materials are lifted by teeth and are stored in waste storage tank. After some times
a motor will be create small cyclone under the drain and One pump motor will suck the
dirt up through the suction pump. And an ultrasonic sensor is attached the upper portion
of the system, is the drain is overflow with the liquid then the system notified the
authors. The entire system is controlled by the micro controller. The motor driver
controls the motor with the signal received from the Arduino. In this way the whole

system is controlled.

35



4.6 Our Final System View

Figure 4.4: Our Final System Overview
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CHAPTER 5
RESULT AND DISCUSSION

5.1 Discussion

While working on our project, we did face some difficulties as it is a very complex
system but the end results, we came up with were quite satisfactory. We have put the
whole system through several tasks to validate our work and also have taken necessary
notes for future improvements. Some future recommendations that we have involves

improvement in system design and wiring, adding features for more efficient.

5.2 Result

Now, it’s time to talk about the results. We have written our commands using the

Arduino IDE and the following things can happen:

e After power this project then it will be able to operate.
e Then a saw teeth will rotate with a chai.
e Then a motor will such the dust of the water and saw teeth will take it up.

e And ultrasonic sensor will detect the drain water level.

5.3 Advantage
There are many advantages of our project because of its accuracy. Some of the advantages

are pointed out below:

Automatic Cleaning System.
Automatic Dust Collecting.

Production cost is very low.

No need of purchase special machine.
Its operated and maintenance is simple.
It is compact and portable.

It can be efficiently used.

Totally wireless controlled.
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5.4 Application

Some of the application areas of the project have been pointed out below:

e Itis used almost in all types if Drainage (Large , Small & medium).
e This machine is mainly used in cleaning system.

e Project to use this in efficient way to control the disposal of wastages and with
regular filtration of wastages.
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CHAPTER 6
CONCLUSION

6.1 Conclusion

In the cleaning system of drainage control by the, motor, roller chain and sprocket, lifter
and the collecting bin to achieve automatic control system. Automation is a technology
concerned with his application of mechanical, electronic and computer based systems to
operate and control production. This system is used to operate automatic drain cleaning
system. We have followed thoroughly the study of time motion and made our project
economical and efficient with the available resources. This system was designed,
fabricated successfully and also tested. It works satisfactorily. We hope that this will be
done among the most versatile and interchangeable one even in future. Thus we can able

to obtain Automatic drain Cleaning system.

6.2 Future Scope
We are thinking about adding many features to our project in the future to get more

desirable outcomes. Some of the steps that we are thinking about taking are given below:

e In the future it can be improved by using more sensors.

e In the future, controlling the Internet can be done to improve it
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